Welcome to the topic on Enhancements in Sending E-Mail in release 9.1
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After completing this topic, you will be able to:
Outline the enhancements in sending E-Mail in version 9.1.
Define the settings for E-Mail sending.
Send mail automatically when adding a document.
E-mail multiple documents to multiple recipients and e-mail aging
report specific information to multiple business partners.

• In version 9.1 you can automatically create and send PDFs by mail when
adding a document.
• You can define a company default on whether to use SBO Mailer or
Microsoft Outlook.
• You can also assign e-mail groups to business partners to be used as
distribution lists.
• As a result you will be able to e-mail multiple documents to multiple
recipients, all in one go.
• And from the aging report, e-mail each customer their own specific aging
information.
• In summary, you improve the flow of documents between the company
and its customers, vendors and leads.
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First, let us discuss the methods for sending mails.
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• In previous versions you could use the SBO Mailer when sending mails
from SAP Business One. When this is used, the SBO Mailer service must be
configured and started in the SAP Business One Service Manager.

• Starting at release 9.1, you can also use Microsoft Outlook when sending
mails automatically.
• For this option, you only need to have MS Outlook installed in your
working station.
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• You can now define a company default on whether to use the SBO
Mailer or Microsoft Outlook when sending mails automatically.
•
•
•
•

This is done on the Services tab of the General Settings.
The first option E-mail sets SBO Mailer as the default.
The second option sets MS Outlook as the default.
Note that a user has the ability to change the mailing method for single mail
sending.
• Also note that the document will be attached as a PDF file to the mail.
Therefore, ensure to define the Attachments folder under the Path tab.
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Next, let us discuss the option to automatically create and send PDFs by mail
when adding a document.
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• Here is a business example:
• OEC Computers set environment saving as one of their objectives for the
coming year. Therefore, they use e-mail to send documents electronically to
customers and vendors.
• To streamline this process further, they want the system to automatically
send the e-mail when a document is added.
• Jean, the sales manager, wants to use this option for the sales quotations
her department creates

• In the Print Preferences window, you can now define for each document type
whether to:
• Automatically export it to PDF and/ or
• Send it by mail when adding a document. The document will be attached as a PDF
file to the mail.

• Use the menu path shown on the graphic. Choose the document type and
check the relevant boxes.
• In the example shown Jean, the sales manager of OEC Computers, decided
that she wants to automatically create and send PDFs by mail when adding a
sales quotation.
• The mail will be automatically sent to the E-Mail address defined for the
document contact person.
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• When you define the print preferences for a document type, you can also
define default text for the automatic e-mail subject and body.
• Use the Insert Predefined Texts button to copy text that is already defined in the
system.
• For the sales quotation, Jean entered default text in the E-Mail Subject and the
E-Mail Body fields.
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• Let us see what happens when adding a document.
• If the company default is the SBO mailer, then when adding the document, the
system populates a message asking if you want to attach an edited report to
the E-Mail.
• When choosing Yes, the Send Message window appears with the details of the
contact person defined in the document
• In the Text tab you can see the default text that Jean entered in the E-Mail
Subject and the E-Mail Body fields (in the Print Preferences window). You can
change this text.
• The sales quotation document you have just added appears under the Data tab
and the created PDF file to be sent in the mail appears under the Attachments
tab.
• Choose the Send button to send the mail.
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• If the company default is the Outlook E-Mail, then when adding the document, a
mail window opens with the contact person mail in the To field.
• The default text that Jean entered appears in the E-Mail Subject and the E-Mail
Body fields.
• And the document is attached as a PDF file to the mail.

• Choose the Send button to send the mail.
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Next, I will show you the option for e-mail documents in a Bundle. That is, e-mail

multiple documents to multiple recipients, all in one go.
In addition, we will see the option of sending several customers their aging
report.
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• Here is another business example:
• Recently, OEC Computers introduced their new products to prospects
and existing customers at an industry conference.
• Jean, the sales manager, created sales quotations to customers and
leads who approached her during the conference. Now, she is looking for
a way to mail these quotations in one go.
• She also wants to address the relevant person in the business partner
organization.

• When using the option to automatically e-mail a document, the mail is
sent to the mailing address defined for the contact person in the
document.
• You can now define E-Mail Groups to specify the recipients within the
business partner organization that will receive the e-mail. The e-mail
group then acts as a distribution list; for example, to send various A/R
Invoices created for different customers to their respective accountants.
• You do that by assigning an E-Mail group to given contact person in the
business partner master data record to be used as a distribution list.
• This way, whenever documents are sent via e-mail to the selected e-mail
group, this contact person receives the document produced for his
company.
• In the example shown OEC Computers has defined three e-mail groups
to be assigned to contact persons:
• One for the warehouse manager.
• Another for the Chief Information Officer.
• And the last one for the company accountant.
• Most likely that sales quotations will be sent to the chief information
officer, deliveries to the warehouse manager and A/R invoices to the
accountant.
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• After you have defined e-mail groups, you select a contact person in the
Business Partner Master Data window, and assign this person to an e-mail
group.
• You can define new e-mail groups from here by choosing the Define New
option.
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• In order to send a batch of documents, for example sales quotations
created for different customers, to the respective contact persons of
these customers, use the document printing window:
• After generating the list of the documents you wish to send by E-Mail,
sales quotations in our example, select the documents by clicking the
first record and then choose the other records with Control or Shift.
• From the File menu choose Send, and then either E-Mail or Outlook EMail.
• Note that the selection of multiple documents requires Crystal Reports
Layout. The PLD layout supports mailing a single document only.
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• After you have selected the documents to be printed, The E-Mail Options
window appears.
• First, you define how to send the selected documents. You can choose
whether to use an E-Mail group or not.
• Select the Use E-Mail Group box and specify the required group to email
the documents to the contact persons associated with the selected EMail group.
• If you clear this box, the selected documents will be sent to the E-mail
address of the contact person defined in the document. If there is no
contact person in the document, then the E-Mail address defined for the
business partner master data under the General tab will be selected.
• You can change the default contact person and the email address in the
next window.
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• After approving the E-Mail Options window, the E-Mail window appears
for the document type, listing the selected documents.
• The name of the contact person and its E-Mail address appear depending on
the selection you did in the previous window. If an E-Mail group was selected
then the details of the contact person associated with the selected E-mail group
appear.
• If the selected E-mail group does not contain a contact person who is
associated with the respective business partners, no name or E-Mail address
will appear.
• You can update the name and the E-mail address manually if required.
• The E-Mail column is selected by default. If you want to cancel sending a
certain document, deselect this option.
• In the Subject and Body columns the text inserted for the given document type
in the Print Preferences window appears. To edit the text, double-click the field
in the required line. A text editor appears, enables you to add and edit text, or
insert any existing predefined text.
• Finally, choose Send.

• As a result, the document will be mailed to each contact person defined
in this window, and therefore to each company.
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• After generating the aging report, either for customers or for vendors,
you can now e-mail the respective aging data to the relevant business
partners.
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• Similarly to the document option, you can define default text for the automatic
mail subject and body.
• Use the menu path shown on the graphic.

• In the slide example, the finance department manager has entered
default text in the E-Mail Subject and the E-Mail Body fields.
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• After generating the aging report, for customers in our example, choose the
business partners you wish to E-Mail their aging data.
• From the File menu choose Send, and then either E-Mail or Outlook E-Mail.
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• Similarly to the sending multiple documents to multiple E-Mail recipients
options, in the E-Mail Options window define whether to use an E-Mail
group or not.
• After approving the E-Mail Options window, the E-Mail Aging window
appears, listing the selected business partners.
• The name of the contact person and its E-Mail address appear:
• If an E-Mail group was selected then the details of the contact person
associated with the selected E-mail group appear.
• Otherwise, the E-Mail address defined for the business partner master
data under the General tab appears.
• You can change the name and the E-mail address manually if required.
• Note that the PDF files with the aging data to be sent are already created
and you can view them. Follow the details in the Source Path and the
File Name columns.
• Finally, choose Send.

• As a result, each contact person defined in this window will receive the
aging data relevant for his company.
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In version 9.1 you can automatically create and send PDF files by mail
when adding documents.
You can define a company default on whether to use SBO Mailer or
Microsoft Outlook.
You can also define default text for the automatic mail subject and body.
By assigning E-Mail groups to given contact person in the business
partner master data record you create distribution lists to e-mail multiple
documents to multiple recipients, all in one go.
This way, whenever documents are sent via e-mail to the selected E-Mail
group, this contact person receives the document produced for his
company.
With the e-mail groups you can also send to several customers their
aging report specific information
You can review the PDF files to be sent before sending them.

Thank you for your time.
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